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Description of Above & Beyond
Above & Beyond is a powerful system for planning, managing, and tracking one's active 
business and personal life.    Innovative dynamic schedules manage workflow more 
effectively than any other method.    All types of recurring activities need be entered just 
once.    You can print schedules to take your plans wherever you go.    Above & Beyond also 
includes a pop-up calendar, alarms, task and event timers, week and month at a glance, and
much more.    There's no better time management system than Above & Beyond.

With Above & Beyond, you can plan time for everything you want to do!

Above & Beyond is also ideal for workgroups.    Where workstations are connected via a local 
area network (LAN), managers can balance the work-load of staff members, assign new 
items, prioritize work, as well as check task completion status without interrupting on-going 
work. Above & Beyond naturally automates the process of arranging meetings for group 
members; posting meeting notices to all attendee's schedules. Secretaries can post phone 
messages for calls to be returned, and monitor multiple schedules to know who is where 
when. 

Above & Beyond streamlines work-flow and productivity soars!

Powerful Advanced Scheduler
Above & Beyond is the world's most advanced time management system. It's amazing 
effectiveness is primarily due to what is called dynamic scheduling. In the section Dynamic 
Scheduling that follows, you'll start to discover how much this can benefit you.

You may just now be discovering Above & Beyond. Welcome! 

Share the Benefits
Certainly many people you know could benefit from using this High Achievement System.    
We encourage you to make copies of Above & Beyond, and give them to others to evaluate; 
or upload Above & Beyond to your local BBS.

Price
Above & Beyond for a single user is    $149.    A five user LAN system is $495.    Ten users: 
$895.    Fifty users: $3495.    One hundred users: $5995.    Call 1Soft at 707-987-0256 for 
additional information on specific size configurations.

Send your comments and suggestions
Product questions and requests for enhancements are welcomed (and always considered). 
Please address your comments to:

1Soft Corporation
Product Comments



Post Office Box 1320
Middletown, CA    95461



Registering Above & Beyond
Be sure to register Above & Beyond by ordering a license. To register, select the Options 
menu and choose Order an Above & Beyond License or choose Order a pre-paid Above & 
Beyond License.    Use "pre-paid" if you have a registration certificate, which is the case if 
you bought the software package through a dealer.    Simply fill out the form, and click on 
"Print" to send the form to your printer.    Send both copies with your check or credit card 
number and expiration date.    Complete instructions appear on the printed form.    

If paying by VISA, MasterCard, or American Express, you can FAX your order form to 707-
987-3150.    If you have questions about your order you may call 1Soft    Corporation at 707-
987-0256.    

The Complete Package
When you purchase an Above & Beyond license, you will receive the complete package 
including the spiral bound User's Guide and program disks in both 3.5" 720K and 5.25" 360K 
formats.

As a registered (licensed) user, you'll also receive a personal User ID and substantial 
discounts on product upgrades.



Distribution Information
You are authorized to make only exact copies of Above & Beyond files to give to others for 
evaluation purposes. Modifying the original content in any way at any time is strictly 
prohibited. This also prohibits temporary modification while the binary data is in RAM. 
Archiving (compressing) distribution files is permitted only for efficient transmission and 
must not alter the original content.

Only individuals licensed by 1Soft Corporation are authorized to use Above & Beyond files on
a continuing basis. Continued active use without registration is prohibited. No other parties 
have been authorized to sell or grant licenses. Various shareware distributors have been 
authorized to sell disks containing Above & Beyond. They are selling disks and a distribution 
service only. They are not selling Above & Beyond licenses.

Liability Disclaimer
1Soft Corporation specifically disclaims any warranty of merchantability or fitness for a 
particular purpose. With respect to defects in its programs and supporting materials and 
service, in no event shall 1Soft Corporation be liable for any loss of profit or any other 
commercial damage, including but not limited to special, incidental, consequential, or other 
damages.

Copyright/Trademark Information
The software files that comprise Above & Beyond are Copyright © 1992 by 1Soft 
Corporation.    All rights reserved.    Unauthorized use is a violation of U.S. and international 
copyright laws.    1Soft and Above & Beyond are trademarks of 1Soft Corporation.



Installing Above & Beyond
The installation process allows you to select where you would like to put Above & Beyond 
files. The directory you name will be created if it doesn't already exist, and the files will be 
copied from the diskette(s) to this target directory. Some files are in compressed form on the
diskette(s) and will be automatically uncompressed as they are installed.

Step 1:Insert the Above & Beyond diskette into drive A:

Step 2:In the Windows Program Manager, Select Run from the File pull-down menu and type:

A:INSTALL

Step 3:    Create a program item (an icon) in the program group of your choice, eg. Windows 
Applications. From the Program Manager, select File, and choose New. Select Program Item. 
As a description, you might type in your name, and for the command line, state the path and
program file, for example:    C:\ab\AB.exe

You can also specify a datafile name, such as:    C:\ab\AB.exe Michael      The extension will be
assumed as PAK.    When you omit the datafile name, the name used is TIMEDATA.PAK by 
default.

If you have a TIMEDATA.PAK file from a prior version of Above & Beyond, it will be 
automatically loaded when you start Above & Beyond 2.0; unless it is stored in a different 
directory.    In that case, copy it to the directory where Above & Beyond has been installed.

Step 4: Start Above & Beyond by selecting the icon you have created and either pressing 
Enter, or double-clicking with the mouse.

Installing Above & Beyond for a LAN Workgroup
Although you can install the program file AB.exe in a shareable directory on the server, and 
have your workstations access it there, it will run faster if installed locally. This is because 
Windows will not have to repeatedly access the server hard drive to read parts of the 
program code into memory. If installed on the local workstation, Above & Beyond will not 
only load quicker, but it will also operate at a faster, more responsive pace. This is true for 
all Windows applications. 

The installation is the same as described above in the section "Installing Above & Beyond" 
with one exception. You will want to have datafiles reside on the server's hard drive. It's 
recommended you designate an individual directory for each user. This will keep .log files 
(completed items are tracked in these files) for each user from being combined.

When you run Above & Beyond, if the directory and/or file you specify does not yet exist it 
will automatically be created for you.

Suppose you have four users: Bill, Karen, Cindy, and Michael;    and the name of your server 
drive is "J". The command lines on the workstations could be as follows:

On Bill's workstation: c:\ab\AB.exe    j:\Bill\Bill

On Karen's workstation: c:\ab\AB.exe    j:\Karen\Karen



On Cindy's workstation: c:\ab\AB.exe    j:\Cindy\Cindy

On Michael's workstation: c:\ab\AB.exe    j:\Michael\Michael



Dynamic Scheduling
Above & Beyond is designed to organize your life and maximize your productivity. It can plan
time for everything you want to do! 

Much of the superior power and flexibility of the Above & Beyond system is based on its 
unique automated scheduling of floating tasks. These schedules are so effective, they render
to-do lists obsolete. Floating tasks are to-do tasks. Unlike fixed items such as appointments, 
they don't have to be done at a precise time. Most of the items of work you do each day are 
floating tasks. These tasks have an anticipated duration to be planned for, but they can be 
performed during some range of hours. Automated scheduling of to-do (floating) tasks 
allows you to plan more precisely than you could with a list, and see clearly how your time is
being allocated. The benefit of using these flexible dynamic schedules is tremendous. The 
following pages detail some of the advantages.

Productivity Gains Through the Day
The best way to illustrate how you can save time throughout the day is to look at a typical 
day, and compare using a to-do list to using Above & Beyond's dynamic schedules. If your 
to-do list has 100 items, and the average task is 15 minutes, then every 15 minutes or so 
you have to stop and decide what to do next. Suppose you spend only one second 
considering each item as you scan a to-do list of 100 items. That's over a minute and a half 
for each scan. If you finish 40 items you will have repeated this scan 40 times in the day, 
spending an hour in the process. This lengthy scanning is eliminated with Above & Beyond. 
You glance at your schedule, see what's next, and begin it without hesitation. You finish 
these 40 items an hour sooner!

And if circumstances require changing your plans during the course of the day that's easy 
with Above & Beyond. If you're at your PC, the schedule on-screen instantly reflects your 
changes, or if you're using a printed Above & Beyond schedule you can make your changes 
on paper, marking up the alterations in your own shorthand.

Having your workflow streamlined leads directly to much higher achievement every day. 
Above & Beyond will boost your performance and rewards in all your pursuits. And provide 
you with more time for leisure pursuits!

Rewards of Higher Achievement
Imagine saving 60 minutes every day! That's 365 hours a year. What would you do with an 
extra 365 hours a year? You've gained the equivalent of nine 40-hour work-weeks. 

Depending on your lifestyle that might translate to an extra two months of vacation, a 18% 
boost in billable hours, self-employment earnings, or commisions, or a hefty raise at your 
next performance review.

Dependability
Above & Beyond reminds you of everything you need to do at the appropriate time. Being 
able to follow-through on promises and commitments you make to others will strengthen 



your reputation for dependability. People trust individuals that have a history of doing what 
they say they'll do. With Above & Beyond, you have the tools necessary to plan with 
confidence. You'll gain the ability to follow through on what you plan to do.

Greatest Return
You'll use daily schedules to eliminate time wasters, planning on doing only what will bring 
you the greatest return.    

Knowing When You'll Get to It
Workload cycles from lulls to hurricanes can be trimmed. 
 
Like most people, you probably feel very busy most of the time. But once in a while things 
slow down. Sometimes suddenly. Maybe you can recall a day when you thought at one point 
"what should I do next?" and nothing especially urgent came to mind. So the rest of your 
day wasn't fully utilized. Lack of challenge can lead to boredom. Often after lulls pass, a 
period of the being too busy comes surprisingly soon: a crisis of not enough time.    
 
Few of us have a life which naturally delivers opportunities to act in a steady flow.    We can 
even exacerbate the ups and downs unwittingly. We may react to a period of too little to do, 
by taking on more and more. Then during a crisis of extreme busy-ness, we may refrain from
accepting any new challenges, and wind up with a lull of nothing interesting to do, when the 
storm passes. 
 
With this scheduler, you can see light periods in advance, and plan accordingly. And you can 
see when future days are filling too rapidly and not take on quite so much before a crisis of 
deadlines occurs.
 
When a lull can be anticipated weeks ahead it can be prepared for and not be dull. Knowing 
you'll be ahead of    your workload a few weeks from now could mean planning for an 
delightful vacation!

Reasonable Expectations
Being able to look ahead and plan reduces stress, and    allows you to inform others. Once 
you have entered your pending tasks you will notice a marked decrease in stress. Because 
all of your tasks are now in a place where they can be managed effectively, you don't have 
to depend on less reliable methods to jog your memory. It's all covered. You can relax. 

Schedule Pacing
Daily schedules enable you to quickly gauge whether you are behind or ahead of schedule 
based on how much you have completed.

Productivity Push
When you know you have a schedule of many vital tasks planned for accomplishment, 



you're more likely to use your time effectively. You know what's next and you know that the 
time you've planned for the current task is finite. Without a planned schedule, there's a 
tendency to merely continue with the comfort of the current task much longer, realizing 
diminishing marginal returns for the extra time spent. With a schedule, you're much more 
likely to move on to the next item. 

Transition Time
No more scanning long to-do lists, plus wall calendars, and appointment books.    Smoother 
transitions boost productivity and effectiveness. 
 
With a to-do list, and no schedule, you know what you have to do, but don't have a plan of 
when to do it. And you don't know what length of time the workload represents. So you 
select one task, and work on it for a while. Then you go back to your list and select the next 
thing, and begin doing it. This creates stress, because you know that if you could anticipate 
what was coming next, you'd be better ready to attack it. One of the big advantages of a 
schedule is that you know what's next. While you're working on task A, you can be preparing
to do task B subconsciously.    You know in advance what tasks you'll encounter throughout 
the day, and in what order. If you've ever watched the Olympic track and field athletes, you 
know that the winning sprinter doesn't stop between hurdles. Running fast and not slowing 
between hurdles is the key to winning times. Imagine if the hurdles are all different heights, 
such as the events in your day. Then anticipating each successive hurdle becomes even 
more crucial. There is a natural desire to look forward to things. To know what's coming, and 
prepare for it. Schedules allow us to do so. 

Window of Opportunity
People rarely forget; they just miss the opportunity window.    Many tasks you seek to 
accomplish can be done only between certain hours. To-do lists hide this fact. If it's a phone 
call to return between certain hours, or an errand that needs to be accomplished within a 
two-hour time frame, then it's a task that cannot be done anytime. Think of all the times 
you've heard yourself say "Ooops I forgot to...." You remembered the task, but only after the 
opportunity was missed. A schedule provides the means to plan time-frame sensitive tasks. 

Log Files
Recall exactly what was done and when, with confidence.

Relief from Office Clutter
Another benefit is helping to keep your desktop and office less cluttered.    A device often 
used to remember tasks, is to leave something related to the task in a conspicuous place 
that will be noticed. Unfortunately, for an active person with much to remember, this can 
lead to an office in complete disarray.    This scheduler allows you to file or store away task 
materials with the confidence that the schedules will show pertinent tasks at the appropriate
time. 



Focus
You can focus mentally without the distraction of thinking about other tasks: trying not to 
forget them, or wondering whether they should be worked on now instead of your current 
task. 

Increased Productivity
While you may grow accustomed to having less time-pressure stress in your life, another 
major benefit will be a dramatic boost in productivity. You'll be amazed at how much you 
accomplish.    You'll get more done in less time. 

Above & Beyond Breaks New Ground
Above & Beyond introduces a new, and more effective way to manage your time. Instead of 
having tasks merely listed in a to-do list, they can be scheduled in the available time 
between the appointments on your calendar. There are several advantages to this approach:
a unified view, time budgeting, time-frame targeting, transition smoothing, and more. 

Integration: a Unified View
Having a unified view means that you don't have to split your attention between your 
appointment calendar and to-do list. Everything you have planned is arranged in the day's 
schedule. No longer do you have to split your attention; you can focus. 

Time Budgeting
Tasks will be scheduled automatically.    At a glance, you can see how much can be 
accomplished and how much space remains in a given day. This minimizes the number of 
surprises and crises that arise when insufficient time remains to accomplish high priority 
tasks before a deadline. And since a schedule is much more precise than a to-do list, you 
can more easily make and keep your commitments to others. You can tell them in advance 
exactly when you plan to have something done. 

Doing it All
One of the most frequent causes of stress we have all experienced is the feeling of having 
too much to do. More specifically, we have a lot to do, and aren't sure if we'll get it done in 
time.    It's this doubt and worry that brings on stress.    Now you can see exactly what you 
have to do and how long it's going to take. Then if it cannot be accommodated before 
deadlines, you can defer lower priority tasks. A renewed sense of confidence in knowing 
what you can get done, and when, will greatly lower your stress level. 

Forget it Not



Another source of stress is worry over forgetting to do certain things before they must be 
done. We all use methods to combat this threat. Unfortunately the methods are not always 
reliable, and result in a certain amount of stress. The key to reducing this stress is simply 
finding a more reliable means to keep track what has to get done, and being reminded of it 
when there's time to do it (before it is too late). 

A More Exciting Life
You will naturally feel more excited about life as you put this time planning system to use. 
With a greater potential for higher productivity you can accomplish all the things you need 
to do, and find time for more of the things you want to do. 

Daily Use
You can gain most of the above benefits even if you use a PC only about twenty minutes 
each day. 

The Morning Planning Session
First, check-off the items that have been completed.    Then reschedule the tasks you didn't 
get to.    You may reschedule them to today's schedule by simply pressing F12.    Or 
reschedule to the date of your choice by clicking on that date on the pop-up calendar with 
the right mouse button.    To view that date, click with the left button.

Add New Items

Add any new items. These might be items you're carrying in your head or those you jotted 
down on yesterday's printed schedule page. 

Arrange Your Schedule

Using the keyboard or mouse, move the items in today's schedule around so that today's 
schedule best suits you. Often today's schedule will be overloaded, but you can defer items 
by rescheduling them to future days.    And you can adjust today's sequence so there are no 
conflicts, and items are in the order you desire, bringing related items together, for example.
As you make changes, you'll notice that the schedule will adjust automatically. 

Print a Schedule Report

You'll want to print off today's schedule, and normally also the extended outlook. The 
extended outlook includes a 3 month calendar, and any highlighted events for up to 90 
days.

It's possible to print your schedule on one-side of the sheet of paper, and turn it over and 
send it through the printer for the extended outlook on the back. This means that you only 
have to carry a single sheet of paper with you throughout the day, which is much easier than



a bulky appointment book, not to mention easier to update.

Jot notes on your schedule report during the day; cross-off items you complete.    Use the 
extended outlook to pin-point what times are committed so you can schedule appointments 
even while away from your PC. 

Suggestions and Tips

Enter the items you plan to do, including regular (recurring) items. This can be done very 
quickly. In the span of about 15 minutes you can probably enter 50 items. Don't forget to 
include the many things you do everyday, such as lunch. These need be entered only once; 
time each day will be reserved for them. There will be additional tasks that you'll think of 
later, and you can enter them anytime. 
 
Then plan today. If today's tasks are not already in a sequence that suits you, arrange them 
and make adjustments, and then print your schedule for the day. If you have a printer, you 
can make a printed schedule to carry through the day, crossing-off items that you complete. 
New items can be noted on this same page, and entered the next morning. If you're using 
the printed schedules and only running the software once daily, you'll spend about 10 to 20 
minutes updating information by marking completed events, entering new schedule items, 
and adjusting your plans according to your latest priorities.

Tasks that you want to reschedule you'll move to future days. The pop-up calendar is handy 
for rescheduling, since you just click the right mouse-button when over a calendar day and 
the selected event will be moved to that day. The updating process is finished when only 
crossed-off items remain on yesterday's schedule. You can edit any of the crossed-off events
to alter the begin time, duration, or other attributes. Yesterday's schedule will later be 
archived to log what you've accomplished. 

Making Backups
Backing up your vital scheduling data is very important. We recommend Making daily 
backups of your data files (*.PAK files) in case a file should get lost or damaged.    Also it's a 
good idea to make at least one backup copy of the program files in    case something should 
happen to the original disk.    For more information, see Data Saving and Making Backups in 
the section entitled "Using Above & Beyond".



Workload Balancing
Workload balancing enables you to automate your planning sessions. And it boosts your 
level of achievement throughout each day. You'll save time planning, and be able to perform 
your work more effectively, accounting for all prorities and deadlines. Any tasks you plan on 
doing that don't have to be tied to a particular date can be designated as "Fluid" items and 
carry a priority and deadline. When you issue the Balance Workload command, Above & 
Beyond will reflow your schedules so that each day is optimized at ideally 100% capacity. 

How Workload Balancing Saves You Time
Workload Balancing relieves you of the work of manually rescheduling/postponing tasks 
when the schedules for the near term are overloaded with items. For most people the near 
term being overloaded is an every day situation. But you can change that with Workload 
Balancing. Automated balancing of the workload is fast, and takes into account all priorities 
and deadlines. 

Life Without Workload Balancing
Suppose for example that you've just carried forward all undone items to today, and you're 
looking at a schedule that's overloaded. Your day is 8am to 10pm, yet there are 70 items, 
totalling 22 hours worth of time packed into the schedule. If you rescheduled 35 of these 
items by hand using the pop-up calendar you might choose from any of the days later in the 
week. That might take 15 seconds per item for you to read the item, and chose a future day 
to reschedule it on. For the 35 items that you decide to keep on today, suppose it takes 7 
seconds each. That's about 14 minutes total. And even if you did this, you'd have broken 
your priorities. Originally, everything on tomorrow's schedule was lower priority than the 
items on today's schedule, yet you've just moved many of today's items to after tomorrow. 

Above & Beyond with Workload Balancing of Fluid items will save you those 14 minutes each
day, and maintain your priorities.

Priorities
Fluid items each have a relative priority from 1 to 999. When you issue the Balance 
Workload command, all Fluid items are rescheduled dynamically. Precedence is given to the 
items in their order of priority. This means that all things being equal, higher priority items 
will be scheduled earlier than lower priority items. The priority 1 item may be scheduled 
today, for example, and the priority 145 item may not come up until next month.    See also, 
the section below titled Changing Priorities.

Earliest/Latest Dates And Weekdays
There are additional properties that fluid items have. The earliest date is known as the 
Postpone date. It is the earliest possible date you would want the item scheduled. The 
Deadline date serves as a latest date. It's the latest possible date for it to be scheduled. For 
tasks that you would only want scheduled on particular days of the week, you can indicate 
with the weekday check boxes. For example, you might designate just Saturday, or maybe 



only Monday through Friday. These properties can be set on the Edit item dialog box. The 
Postpone date, Deadline date, and Weekdays are all optional.

How To Create A Fluid Item
If you're in the "Insert/Refine Item" dialog box, click on (to remove the X from) the Firm 
checkbox. This will switch off the Firm setting, making the item Fluid. If you are inserting an 
item from the Priority Ordered List view, the box will automatically be switched off to give 
you a Fluid item initially.

To toggle an item between Fluid and Firm press F2, or choose "Fluid Item" in the Edit menu.

Recurring items are normally not fluid, but you can make an exception. If you press F2 on an 
instance of a recurring item, it will change it to an exception and make it fluid.    Or select 
"Exception" in the Insert/Refine Item dialog box and then switch off the Firm check box to 
make that instance Fluid.

Changing Priorities
The top priority item has a priority value of 1, the next 2, etc. You can view all the Fluid 
items by selecting Priority Ordered List. The priority of an item can easily be changed in a 
variety of ways. You can slide the item up or down in the priority list to raise or lower its 
priority. You can edit the item and change the priority value by typing in a new value or 
using the scroll bar to quickly move it up or down. 

The Balance Workload Command
Simply press ALT+F8 (or select Juggle: Balance Workload) and Above & Beyond will adjust 
item scheduling on all future days. The priority, duration, and begin time (if any) is taken 
into consideration. Higher priority items are given precedence, but there are exceptions. 
Items of shorter duration, for example, are easier to find time for, and may be scheduled 
before a long duration item of higher priority. 

If time cannot be found for the item before its deadline, a warning message will appear, and 
you'll have an opportunity to make changes, such as increasing its priority or extending its 
deadline. When no messages appear you will know that all tasks have been scheduled 
before their deadlines.

Using The Pop-up Calendar With Fluid Items
The popup calendar, so useful in quickly rescheduling Firm items, also has benefits in 
juggling Fluid items.    If you want to postpone a Fluid item to next week, click the right 
mouse button on the date you'd like to postpone it to. Don't worry about postponing past the
deadline, because Above & Beyond will check deadlines and warn you if you pass one. You 
can then chose to not postpone the item, or have the deadline extended. When you 
postpone an item it will not be scheduled prior to that date.    If you later decide you want to 
move it up, you can do so by clicking on an earlier date on the calendar.    The Postpone and 
Deadline dates can also be changed in the Insert/Refine Item dialog box.



Make Whatever You Can Fluid
To get the greatest gain out of Workload Balancing, designate as many items as you can as 
Fluid. Ask yourself, "Can this be done on other than one particular date?"    Events and 
appointments are normally Firm, and would not be Fluid items. But many things, perhaps 30-
60% of your items could be Fluid. The more fluidity you can designate in your schedules, the
easier it is to balancing your workload.

How To Handle The Unexpected
If your work and lifestyle sees unexpected items come up at the last minute, you may want 
to adjust workload balancing so that it doesn't try to plan a solid day everyday for you. 
Suppose your waking day is from 8am to midnight, 16 hours, but you want to allow for 4 
hours of unexpected items. Create a daily recurring item titled "Unexpected" that lasts 4 
hours.    (Two items of 2 hours each will work even better). Workload balancing then will take 
the unexpected blocks of time into account when scheduling fluid items. 

What If The Schedule Still Jams Up?
At the top of each schedule there is displayed the amount of Conflict time. This is the total of
any overlaps among items in the viewed schedule. Conflict time will ideally be close to zero 
when using Workload Balancing, but it you have too many Firm items on a particular day, 
the schedule will still be jammed after Workload Balancing. The solution is to either 
reschedule these Firm items manually or toggle them to Fluid items where feasible.

When To Use The Workload Balancing Command
With experience you will become adept at using Above & Beyond in just the fashion that 
suits you. But to give you a headstart, here are some suggestions. We'll suppose you're 
having a single planning session each day.

1. Review yesterday's schedule, checking off done items, and filling in their hours if you 
want an accurate log. If you edit them in order, you will find that Above & Beyond will fill in 
alot of the values for you. For example, when you check off an item, it changes the begin 
time to coincide with the end time of the previous item in the schedule. If you're adding 
items that were done yet not in the schedule, use F10 (Insert Done Item). The begin time will
also be filled in here automatically, based on the end time of the    currently selected item.

2. Issue the Carry Over Undone Items command.

3. Insert any new items, and delete any obselete ones.

4. Go to the Priority List View. Review your priorities and make any adjustments.

5. Issue the Balance Workload command.

6. View today's schedule, and arrange it to suit your preferences.



7. Print today's schedule. If you think you might have extra time open up, print the First Page
of the Priority List which will give you a priority ordered list of items.

Time Savings with Workload Balancing
The 14 minutes estimated previously for rescheduling a busy schedule manually can all be 
saved each day by taking advantage of WORKLOAD BALANCING. That'll save you 90 hours 
annually. Enough time for an extra two week vacation every year.

Tips on Juggling Priorities
Workload Balancing is of most value to those with particularly heavy workloads. If you find 
that your List of Fluid items grows to more than 20 items, there's an additional tip that will 
help. It's conceivable your priority list could have more than 100 items. Suppose you have 
150 items. You wouldn't want to review the priorities and make adjustments of all 150 items 
everyday. Probably only the first 10 or 20 are going to come up right away. Focus on those. 
To make it easier, create an item with a title such as "------- LATER ------" you can then use 
this item as a placeholder at some comfortable position in the priority list. You can more 
easily organize just the group of top items that you are actively prioritizing each day. If you 
have a major milestone coming up and want to defer items until after it, you could create an
item such as "----- AFTER THE XYZ PROJECT IS DONE -----".



Schedule Notation
The first line of each schedule displays a convenient summary of the schedule shown in the 
window.    What is displayed is the day and date of the schedule, the number of items in that 
day's schedule, the amount of time taken up by the items in the schedule, and the amount 
of time left unscheduled in that day (open or free time).    If there are "conflicting" items -- 
items that are scheduled for the same time period -- the total overlap time is displayed.    On 
past schedules, the number of undone items will also be reported in the banner line.
 
If the schedule being viewed is the one for the current day, an asterisk (*) will appear after 
the date in the banner line.      
 
If the schedule being viewed is not the schedule for the present date, a number will appear 
after the date in the banner    line preceded by a plus (+) or a minus (-).    A number 
preceded with a plus indicates that the schedule being displayed is that number of days in 
advance, or in the future, of the present date.    A number preceded by a minus indicates 
that the schedule shown is that number of days behind, or in the past from, the present 
date. 

An arrow (>) will appear before the title of the item that is scheduled for the current time.    
A tilde (~) will appear before the title of fluid items.    Schedule statistics will change as items
are added, deleted from or modified in a schedule or as schedules for different days are 
selected.

Start Times Grayed

On today's schedule, item start times will appear gray if the start time has already past.    
Also, if you move an item to a spot where it conflicts with another item or goes outside of 
the time bounds you designated, the time will appear gray; warning you of the conflict.    
Keep this in mind when juggling items.

International Time & Date Formats

Above & Beyond supports world-wide date and time formats.    Use the Windows Control 
Panel to select your choice of time and date format.    For example:

14:00 dd/mm/yy Australia, United Kingdom, Belgium, Brazil
14:00 yy-mm-dd Austria, Candada, Portugal
15.00 dd-mm-yy Denmark
15.00 dd.mm.yy Finland
14:00 dd.mm.yy France, Germany, Norway
14:00 dd/mm/yy Italy, Netherlands, Iceland, Spain, New Zealand
2:00 dd/mm/yy Mexico
2:00 yy.mm.dd South Korea
15.00 yy-mm-dd Sweden
16,00 dd.mm.yy Switzerland
2:00 mm/dd/yy United States, Taiwan



Selecting Schedules
See the Select menu for the commands for selecting which schedule to view.    Or simply 
click on the desired date on the pop-up calendar.

There are several methods for moving between schedule days.    You may move ahead or 
back by days, weeks, months, or years.    These methods are explained in the sections that 
follow.    Remember that no matter how far you go ahead or back in time, you can always 
return to today's schedule by simply pressing the HOME key.    

Selecting a Specific Date
Selecting a Day at a Time
Selecting a Week at a Time
Selecting a Month at a Time
Selecting a Year at a Time



Selecting a Specific Date
To select a schedule for a specific date, simply click on the desired date on the pop-up 
calendar.

Or press F9 and type in the date.    Dates may be entered as "month/day/year" using slashes,
hyphens, spaces or periods.    Often the year may be omitted.    See Entering Item Date for 
more information on when the year may be omitted.

To select the schedule "n days from now" simply type in a number "n".    To select the 
schedule one week from now, type "1w".    For two weeks from now, type "2w".    For two 
months from now, type "2m".

You may also enter the name of the day of the week, or an abbreviation such as "M", "Tu", 
"W", "Th", "F", "Sa", or "Su".    To select next Monday, type in "M".    For two weeks from next 
Monday type "M2".    For three weeks from next Tuesday, type "Tu3". 



Selecting a Day at a Time

There are shortcuts to selecting the schedule for date one day earlier or later than the one 
being displayed: 
 
Press the gray PLUS (+) key on the numeric key pad and the schedules will advance one day.
 
Press the MINUS (-) key on the numeric key pad and the schedules will roll back one day. 

Or with the mouse...
 
Click on the right-pointing arrow at the far right end of the horizontal scroll bar at the bottom
of the schedule screen, and the schedules will advance one day. 
 
Click on the left-pointing arrow at the far left end of the horizontal scroll bar at the bottom of
the schedule screen, and the schedules will roll back one day. 



Selecting a Week at a Time

There are shortcuts to selecting schedules weeks apart:

Press F7 to view the day one week earlier.

Press F8 to view the day one week later.

Or with the mouse...
 
Click in the gray area on the left half of the horizontal scroll bar at the bottom of the 
schedule window to view the day one week later.

Click in the gray area on the right half of the horizontal scroll bar at the bottom of the 
schedule window to view the day one week later.



Selecting a Month at a Time

The pop-up calendar with a mouse can be used to quickly move the display by months at a 
time:

Month to month moves of the pop-up calendar, are directed with the up and down arrow 
keys when the pop-up calendar has the focus.

Or with the mouse...

Click on the up-facing arrow at the top end of the vertical scroll bar on the right side of the 
pop-up calendar, and the calendar will advance one month.    Then, click on the desired date 
in the calendar and that schedule will be displayed. 
 
Click on the down-facing arrow at the bottom of the vertical scroll bar at the right side of the 
pop-up calendar, and the calendar will roll back one month.    Then, click on the desired date 
in the calendar and that schedule will be displayed.    



Selecting a Year at a Time

The pop-up calendar with a mouse can be used to quickly move the display by years at a 
time:

Year to year moves of the pop-up calendar, are directed with the PageUp and PageDn keys 
when the pop-up calendar has the focus.

Or with the mouse...

Click in the gray area on the top half of the vertical scroll bar at the right side of the pop-up 
calendar, and the calendar will advance one year.    Then, click on the desired date in the 
calendar and that schedule will be displayed. 
 
Click in the gray area on the bottom half of the vertical scroll bar at the right side of the pop-
up calendar, and the calendar will roll back one year.    Then, click on the desired date in the 
calendar and that schedule will be displayed. 



Inserting Items Into a Schedule
Select the schedule for the date on which you wish to schedule the item, and press INSERT.    
You can also double-click on any open space on the schedule screen (not on a existing item). 
A dialog box will be displayed which will guide you in quickly entering the pertinent 
information about your item. 
 
If you were to press ENTER, without typing any information into the dialog box, an untitled 
item would be entered in your schedule for that day at the earliest free space with a 
duration of 10 minutes. 

Entering Item Title
Entering Item Duration
Entering Memos
Entering Item Date
Scheduled / Unscheduled Items
Begin Time and Floating / Fixed
Firm / Fluid
Time Bounds
Setting Alarms



Entering Item Title

The title (description) of your item can be up to 365 characters long.    When you have 
entered the title of your item, press the TAB key to advance the cursor to the next text box.



Entering Item Duration

Here is where you enter the amount of time you think a item will take. If you are uncertain of
how much time the item will take, your best estimate will still be helpful for planning.
 
You may enter complete times like "2:00" for two hours or "1:45" for 1 hour and 45 minutes, 
or you may use the following short forms:    The numbers 1 through 99 are interpreted as 
minutes, while 100 through 2359 will be assumed to be hours and minutes.    145 for 
example is assumed to be 1:45.    You may enter durations of up to 24 hours.    An item with 
duration zero is called a "memo".

Note that a period can be used in place of the colon.    This European format is easier to type 
as the shift key is not used.



Entering Memos

To flag an item as a memo, either type "memo" or the digit "0" (zero) in the Duration box.    
When the item is inserted into the schedule, the word "memo" will appear on the right side 
of the description.    If you choose to make the item an unscheduled item (as described in the
"Scheduled / Unscheduled Items" section below), then the item will appear at the top of the 
day's schedule with the word "memo" on the left, where the begin time would ordinarily be. 

A shortcut for entering memos into your schedule is to press ALT+INSERT or select "Edit: 
Insert Memo Item".    This will bring up a definition dialog box for a new unscheduled item 
with duration zero (i.e. a "memo").    As with any unscheduled item, memos will not conflict 
with scheduled items nor be calculated into the workload by the color utilization calendar.



Entering Item Date

This is the date on which your item is to take place.    The date of the schedule which you 
selected when you called up the definition (insert) dialog box, will automatically appear in 
this box.    If you decide that you'd like your item to be scheduled on another day, enter that 
date here. 
 
Dates may be entered as "month/day/year" using slashes, hyphens, spaces, or periods as 
separators.    

Examples:  9/23/92            9-23-92            9 23 92              9.23.92

You need use only two digits to specify the year.    Specifying values between "90" and the 
"99" are assumed to be years between 1990    and 1999.    Specifying values from "00" to 
"68" are assumed to be years between 2000 and 2068.    If you omit the year, (e.g. 9/23) the 
year will be assumed to be the next occurrence of the date.    The exception to this is if the 
date is within six months in the past.    In this case the date is assumed to be the past date 
rather than the next (future) occurrence of the date.

To specify "n days from now" simply type in a number "n".    To specify one week from now, 
type "1W".    For two weeks from now, type "2W".    For two months from now, type "2M".

You may also enter the name of the day of the week, or an abbreviation such as "M", "Tu", 
"W", "Th", "F", "Sa", or "Su".    To select next Monday, type in "M".    For one week from next 
Monday type "M1".    For two weeks from next Monday, type "M2". 
 



Scheduled / Unscheduled Items

The "Scheduled" box gives you the option of having your item appear on your schedule with 
a begin time, or you may elect to have it appear    without a time associated with it, thereby 
making it an "unscheduled" item.    Designating your item or items as unscheduled is a 
convenient way to post notes or comments on your schedule. 
 
When a new item is inserted, the default setting is that it is a "scheduled" item.    To 
designate this item as "unscheduled", click the mouse on the "scheduled" check box. To 
replace the X, and make this a "scheduled" item, simply click the "scheduled" check box 
again. 



Begin Time and Floating / Fixed 

When you leave the "Begin time" text box empty, the "Floating" option is automatically 
selected. "Floating" means your item can take place over the range of time specified in 
Options: Set New Item Defaults.    The item will be inserted into the schedule at the earliest 
open time, taking into account the duration of the item, other items already scheduled, and 
the bounds you specified

With the exception of "Fluid" items described below, Above & Beyond will keep the 
sequencing of items as you have arranged them.    Because of this, you can prioritize items 
by sequencing them, and that sequence will be maintained. You can change the sequence of
items by simply dragging them with a mouse (or using the commands in the Juggle menu).
 
The dynamic scheduler    will do much of the scheduling work for you. To maximize the power
of the dynamic scheduler, omit the begin time for all those items which have a flexible start 
time.    Enter a time in the "Begin Time" box only if an item must begin at a specific time, 
such as a lunch date or meeting.    As the begin time is entered, the "Fixed/Floating" option 
automatically switches to "Fixed". 
 
In 12-hour format, times may be entered as "3:00" for 3 o'clock pm, "9:45" for 9:45 am or 
"6:3" for 6:30pm.    If no "a" (am) or "p" (pm) is typed after your time, it will automatically 
appear between 8:00am and 7:59pm. Typing "9:30" into the text box will appear as "9:30a" 
and "6:20" will appear as "6:20p".    You may also enter numerals only, leaving out the colon 
completely.    Typing "4" will appear as "4:00p" and "912" will appear as "9:12a". 

24-hour time format is also supported: "5:00" (or "0500") for 5am and "17:08" (or "1708") 
for 5:08pm.    

Use the Windows Control Panel to select 12/24-hour and international time formats. 



Firm / Fluid
In the "Insert/Refine Item" dialog box is an check box labeled "Firm".    By de-selecting 
(removing the "x" from) the "Firm" check box, items are considered to be "Fluid", which 
means that they can flow (forward or backward) between days when the Workload Balancing
command is selected.    Workload Balancing will reschedule Fluid items based on their 
priority and the best fit into the available free time.    The date range within which a Fluid 
item may flow is specified by the "Postpone" and "Deadline" dates.    That is, it will be 
scheduled before "Deadline" but after "Postpone".

For an in-depth discussion of Fluid items, see the section titled Workload Balancing.



Time Bounds

You may select a time range in which you would like to have an item scheduled.    For 
example, if you need to make a phone call to a colleague who will only be in his office 
between 9:00 and 11:30am tomorrow, enter these times in the boxes labeled "Earliest" and 
"Latest".    The dynamic scheduler will schedule "floating" items within these specified 
bounds.

In many cases you may simply leave the bounds boxes empty.    If this is done, the bounds 
used will be those you have specified in Options: Set New Item Defaults.    In addition to 
saving keystrokes, this method has the additional benefit that you may later "globally" 
adjust the bounds of all floating items by simply changing the bounds in Options: Set New 
Item Defaults.

For "fixed" items (items with a fixed begin time) the "Bounds" boxes will be seen in gray and 
will be inactive. 



Setting Alarms

Alarms may be set on any schedule item or memo.    When the alarm sounds, a message box
will pop-up alerting you to the starting or ending time of the item.    The alarm will chime 
every 60 seconds until you acknowledge it.    You will be asked if you would like the alarm 
repeated, and if so, when. 

To set an alarm, click on the Alarm check box (or press ALT+A) in the Insert/Refine item 
dialog box. This will place an X in the check box, to show that the alarm is now on, and will 
also bring up the Alarm dialog box.    In the Alarm dialog box, you have the opportunity to set
the alarm to go off either before or after an item is scheduled to begin, or before or after an 
item is scheduled to end.    You can also indicate the amount of time (up to 99 minutes) 
before or after the item that you would like the alarm to go off. 
 
If the "Begin time" box is marked with an "X", the alarm will sound before (or after) your 
item is scheduled to begin.    Click on the check box to remove the "X".    Click a second time 
to replace it.    You may elect to have both the "begin time" and "end time" boxes marked so 
that the alarm will go off twice, both before the item begins and before the item ends (or 
after, if "After" is selected).    
 
Selecting "OK" will set the alarm with the information you have given it and bring you back 
to the definition dialog box.    Select "OK" again and the item will appear on your schedule 
with "-a" after it.    This indicates that    the item has an alarm set.    An item followed by "-ar" 
indicates that the alarm has gone off and has been set to repeat again later today.    An "-ax"
indicates that the alarm has gone off and will not be repeated today.
 
In the Alarm dialog box pressing ESC will cause the changes just entered to be cancelled,    
however, the alarm will still be set.    Selecting "Cancel" will    have the same effect.    
 
To disable the alarm, you can delete the "X" from the check box to the left of the "Alarm" 
command button in the main dialog box.    Do this either by clicking on the check box or by 
putting the cursor next to the check box with the TAB key, then pressing the SPACEBAR.

The alarm sound may be tested by setting Alarms Off and then back on again    This is done 
in the Options menu.



Recurring Items
If you have an item that occurs on a recurring basis, it is not necessary to go to each date to
insert the item. While working in the definition dialog box, simply click on the "recurring" 
command button or press ALT+R. This will bring up another dialog box in which you may 
designate how often and on which days you'd like the item to appear on your schedule.

The following topics explain the options in the "Recurring" dialog box. Once you have 
finished your session in the "Recurring" box, click on "OK" (or TAB to the OK    button and 
press ENTER).    This will return you to the definition dialog box.    The "Date" button no longer
contains a date but is marked "Recur'ng".    On your schedule the item will be followed by "-r"
to indicate that it is a recurring item. 
 
Note: While working in the "Recurring" dialog box, you may decide that you don't want your 
item to be recurring. Press ESCAPE (or TAB to the "Cancel" button and press ENTER).

Unlike most scheduling programs, 1Soft schedulers allow you delete or change all 
occurrences (instances) of a recurring item in a single operation, so you don't have to delete 
each and every occurrence one by one. The Delete All Occurrences command is in the Edit 
menu, and its shortcut is CTRL+DELETE.

Recurring Daily
Recurring Every __ Days
Recurring Weekly
Recurring Every __ Weeks
Recurring Monthly
Ordinal Weekdays
Recurring Every __ Months
Recurring Annually
Entering Birthdays
Recurring to Non-recurring
Delete All Occurrences
Exceptions to Recurring Items
4-4-5 Quarterly Calendar



Recurring Daily

When the "Recurring" dialog box first comes to the screen, the "Daily" option button is 
selected.    Click on, or press TAB to move from the "Daily" button to the text box titled 
"Starting".    The date in this box will automatically be the date of the schedule you are 
presently working with.    You can change this date to a later date by entering it as 
"month/date/year".      
 
Click on, press TAB again to move to the text box titled "Ending". This text box will be blank, 
and if left blank will cause your item to be inserted into every daily schedule indefinitely.    
You may type in the date of the last day that you would like your item to take place.    Click 
on "OK," or press TAB to select the "OK" command button and press ENTER. The "Recurring" 
dialog box will disappear and the definition dialog box will return to the screen.



Recurring Every __ Days

Your item may not need to take place daily but every so many days.    When in the 
"Recurring" dialog box, click on (or press the DOWN or RIGHT arrow key to select) the button
labeled "Every ___ Days".    You may chose to keep the default setting (2) or you may enter 
any number up to 99.    Press TAB    to bring the cursor to the text box and type in the 
numerals. 
 
Specify "Starting" and "Ending" dates as with Daily items and press ENTER when you are 
finished.    Remember that leaving the "Ending" text box blank will cause your item to be 
scheduled into the future indefinitely. 



Recurring Weekly

To schedule a weekly item, in the "Recurring" dialog box, click on the "Weekly" button, then 
click on the check box for each day on which you want the item to be scheduled. 
 
If you are not using a mouse, press the DOWN arrow key twice to select the button labeled 
"Weekly", then TAB to the series of seven check boxes labeled for the days of the week.    
The cursor will appear as a gray vertical line to the right of the check box labeled "M".    Press
the space bar to fill in this box with an "X."    Press the RIGHT (or LEFT) arrow key to move 
the cursor along the row of boxes. 
 
You may also choose to leave all the day-of-the-week check boxes blank and tab directly to 
the "Starting" text box.    This will cause your item to be scheduled once a week on the week-
day that your "Starting" date falls on.    For example, if the "Starting" date falls on a Monday, 
then your item will be scheduled each week on Monday. 



Recurring Every __ Weeks

To schedule an item at an interval of every two or more weeks, click on (or use the DOWN 
arrow key to select) the button labeled "Every ___ Weeks".    The default setting here is 2.    
You may enter any number up to 99.    Note: Entering the number "1" in this text box will 
cause the button selection to change automatically from "Every _1_    Weeks" to "Weekly".      
 
As with Weekly recurring items, you may check the boxes to indicate on which day(s) of the 
week the item will occur.    As stated earlier, if you chose to leave all of the day-of-the-week 
boxes unchecked, your item will be scheduled on the day of the week that the "Starting" 
date falls on. 



Recurring Monthly

Items may be scheduled once, several or many times each month.    In the "Recurring" dialog
box, click on (or press the DOWN arrow key to select) the button labeled "Monthly on...". 
 
Using a mouse, simply click on "Cardinal Month Days", then click on the check boxes for 
each of the desired days. 
 
Without a mouse, press TAB to select "Cardinal Month Days".    Press TAB to move the cursor 
down to day "1" in the calendar. The cursor is now a dotted gray outline around the check 
box. Mark the boxes you wish by pressing the SPACEBAR.

Using "Cardinal Month Days", if all the check boxes are left blank, the item will be scheduled 
each month on the same day of the month as the "Starting" date. 



Recurring on Ordinal Weekdays

You may want to schedule your item to take place on a certain day each month; for example,
the first Friday and the second Wednesday of every month.    To do this, select "Monthly 
on..." and click on the button labeled "Ordinal Weekdays" (or press ALT+O).    You can move 
around this calendar and mark the boxes in the same way as with "Cardinal Month Days".



4-4-5 Quarterly Calendar
While the traditional quarter begins on the first day of the first month of the quarter, in the 
4-4-5 system, the quarter begins on the first day of the first week of the quarter. The first 
month of the quarter always has 4 weeks, the second month 4 weeks, and the third 5 weeks.
4-4-5 quarterly calendars are popular because of their uniformity. 

Many companies make frequent use of the 4-4-5 system to schedule recurring meetings. 
Here are a few examples:

1)    Meeting on the 4th Wednesday of each month
2)    Meeting on the 2nd Tuesday of each quarter
3)    Meeting on the 7th Friday of each quarter.

1)    Use as a starting date the first day of the first quarter you want to schedule it. Then 
choose every month, 4th Wednesday.

2)    Use as a starting date the first day of the first quarter you want to schedule it. Then 
choose every 3 months, 2nd Tuesday.

3)    Use as a starting date the first day of the second month of the first quarter you want to 
schedule it. Then choose every 3 months, 3rd Friday.

If you don't know the first day of a particular 4-4-5 month or quarter , you can simply enter 
the first day of the corresponding traditional month and it will be converted.

To have Month at a Glance, the pop-up Calendar, and the Extended Outlook (13 week 
printout) appear in 4-4-5 format, select Options: Calendar: 4-4-5.    To toggle this option off, 
simply select it again.



Recurring Every __ Months

To schedule an item at an interval of every two or more months,    in the "Recurring" dialog 
box, select the button marked "Every ___ Months...". The change the default setting of 2, 
click in, or press TAB to move the cursor inside the text box. 
 
As with Monthly recurring items, select the desired "Cardinal Month Days" or "Ordinal 
Weekdays". 



Recurring Annually

To schedule an item once a year, in the Recurring dialog box select the button labeled 
"Annually".          
 
Click on (or press TAB to move the cursor to) the "Starting" and "Ending" text boxes.    Fill in 
the dates of your choosing and click on "OK", or press ENTER.    The item will be scheduled 
each year on the date entered in the "Starting" text box.



Entering Birthdays

To enter birthdays use "Insert note item".    Enter the desired text, then click on "Recurring".   
In the recurring dialog box, choose "Anually".    Specify "Starting Date" as the next 
occurrence of the birthday; NOT the actual birthday.    The reason for this is that    the actual 
birthday may be outside of the range of Above & Beyond dates.



Recurring to Non-recurring

To change a recurring item to a single-occurrence item, in the definition dialog box click on 
(to remove) the "X" from the check box to the left of the "Recurring" button.    Without a 
mouse, TAB to put the cursor on the right side of the check box, and press the SPACEBAR. 
Each time you click on the check box or press SPACEBAR, the recurring status of the item 
switches, from recurring to non-recurring and back again.    An "X" in the check box indicates 
that the item is recurring, while an empty check box indicates that the item is a single-
occurrence item. 
 
When you change the status of an item to non-recurring this way and then press OK, all 
occurrences of the item will be deleted with the exception of the one instance that is 
selected. 



Delete All Occurrences

There are two methods you can use to remove all occurrences of a recurring item.    The first 
is to select any occurrence of a recurring item on any schedule, then select "Delete All 
Occurrences" from the Edit menu.    
 
The second method is to first choose the "Alphabetical Items List" in the View menu (ALT+V, 
A), select the recurring item on the list, press the DELETE key. 



Exceptions to Recurring Items

Perhaps a meeting which is normally scheduled to take place on the first Monday of every 
month will be moved to the following Tuesday because of a holiday that Monday.    Or 
perhaps your daily lunch, normally at 12:30 needs to be extended next Friday to 90 minutes 
and moved to 12:00 for an achievement awards luncheon.

There are quick and easy ways to make exceptions; but first, an overview: Simply select any 
standard instance of the recurring item on any schedule day and bring up the definition 
dialog box by pressing ENTER or by double-clicking on the item.
 
Now, click on the Next button (or press ALT+N) to advance the date shown above the Next 
button to the date of the next occurrence of the item.    Similarly, click on the Prior button (or
press ALT+P) to display the date of the previous occurrence of the item.    When the date of 
the item occurrence that you wish to modify is showing, you may...    
 
            Press ALT+C      --    To    Cancel (delete) this occurrence of the item or...

            Press ALT+X      --    To    indicate that this occurrence of the item
is different in some way, then... 

              
Make the desired changes in the upper portion of the definition dialog box and select OK.    
The schedule for the date of the modified occurrence will appear on the screen. To the right 
of the item title will be an "-rx" to indicate that this is an exception to a standard recurring 
item. 
 
Note:    If you would like the modifications entered to become the new standard for the 
recurring item press ALT+S (for Standard)    while still in the definition dialog box. 

To quickly Cancel (Delete) ONE instance of a recurring item, select that item in the schedule 
on day you want it cancelled. Then press delete.

To quickly change the date of one instance of a recurring item, select the instance, and 
simply move it to another day. 

To quickly change the duration (or any other details) of one instance of a recurring item, 
select the instance and press ENTER (or double click on the item.)    When the Refine dialog 
box appears, press ALT+X (or click on the Exception option.)    Change the information and 
press OK.

When the Standard (ALT+S) option is on, changes in the Refine dialog box affect all standard
instances.
Changes in the Recurring dialog box (daily, weekly, etc.) affect only the standard instances.



Changing Item Information
To change any information for an existing item, first double-click on the item description line 
on the schedule window (or select the item and press ENTER).    Then, click on (or TAB to) the
appropriate box and enter the changes.    If the desired changes are to the "Recurring" or 
"Alarm" settings, select these dialog boxes by clicking on "Recurring" or "Alarms".

To save the changes select OK.    To return the item to the schedule without any of the 
changes taking effect, press ESCAPE or click on "Cancel" (or TAB to "Cancel" and press 
ENTER).    

To make changes to a recurring item, select any STANDARD instance of the item.    If you 
select an instance of the item that has been designated as an exception, then the changes 
will only affect that occurrence of the item. 



Deleting Items
Click once on the item in the schedule (or use the arrow keys) to select it, then press the 
DELETE key (or press ALT+E, D).    A message will appear, asking you to confirm the delete 
command.    Click on "Yes" (or TAB to "Yes" then press ENTER) and the item will be removed 
from the schedule.    If you click on "No" (or press ENTER with "No" selected) the item will not
be deleted. 



Juggling Items
Once an item is inserted into your schedule, you may move it to a different position within 
that schedule or move it to the schedule of a different day.    If you are not using a mouse, 
see "The Juggle Menu" in the Menu Commands section, or pull-down the Juggle menu and 
you'll see the keyboard-equivalent shortcuts. 
 
Using a mouse, click to select the item you wish to move, then simply drag the item up or 
down within the schedule. When you move a "floating" item up or down on the schedule, the
begin time of the item will adjust automatically. Even if you have designated an item to take 
place at a fixed time, it is possible to move that item up and down in sequence on the 
schedule, however the time you specified remains the same. 
 
To move a selected item to another schedule, simply click with the right mouse button on 
the desired target date in the pop-up calendar. This is the quickest and easiest way to 
reschedule an undone item to another day.
 
Or, while viewing multiple schedules, drag the selected the item from one schedule window 
to another. 



Highlighting an Item
For emphasis, you may wish to highlight certain items on your schedule. Highlighted items 
appears in the schedule as underlined and will be printed when "Extended Outlook" is 
selected.    See the Print commands in the File menu for more information on the Extended 
Outlook. 
 
The "Highlight Item" command will underline the currently selected item.    A shortcut for this
command is to press F3 while in the schedules window.    Press F3 again to remove the 
underline.    Items you wish to appear in the "extended outlook" Month-at-a-glance view 
must be highlighted.



On Screen Views
One to seven schedules can be viewed on screen simultaneously.    The schedules may be 
stacked    vertically, or tiled horizontally.    You may also view a list of all items, either ordered 
by priority, or alphabetized on item title.    These view options and others such as Month at a 
Glance are selected in the View menu.    For more information, see The View Menu in the 
Menu Reference Section.



Printed Schedules
You may print reports that list your schedule for the present day and beyond;    plus a three 
month calendar. This allows you to see openings for appointments while away from your 
computer. All highlighted (underlined) events for the next three months also may be listed 
by choosing the Extended Outlook option. See the Print commands in The File Menu section 
for details. 

Printed schedules have vertical spacing proportional to time span.    This makes it easier to 
see the relative durations of each item.    Items of longer duration will have more blank space
below the row they appear on, than those of shorter duration.



Notes
Notes of varying lengths can be attached to items. They may also be printed.    For more 
information on notes, see Edit: Notes in the Menu Reference Section.



The Toolbar
Just below the Above & Beyond banner line is a toolbar which contains icons for quickly 
accessing a variety of commonly used commands.    Note: To remove the toolbar from view, 
click on the small upward pointing triangle just above the vertical scroll bar.    To restore the 
toolbar, click again.

Select: Prior Week

Select: Prior Day

Select: Today's Schedule

Select: Next Day

Select: Next Week

View: Single Schedule Window

View: Week at a Glance

View: Month at a Glance

View: Alphabetical List

View: Priority List

Select: Search

Options: Calendar: Open

Worktools: Timer

Worktools: Autodial

View: Browse Notes

Edit: Notes



Edit: Start Item

Edit: Item Done

Edit: Delete Item

Juggle: Carry Over Undone Items

Juggle: Balance Workload

File: Print: Today's Schedule



Data Saving and Backups
To minimize data loss from unexpected natural disasters such as power interruptions, 
schedule changes are saved every 60 seconds in your data file which has the .PAK 
extenstion.    As an added precaution,    a backup file is maintained which contains your 
previously saved scheduling data.    It has the extension .BAK.

Should a power interruption occur, and you have made changes within the last minute prior 
ot the interruption, see the file in your data directory with the .CNG extension.    This file lists 
all additions and deletions that you made today.    It also shows the exact time the changes 
were made; so it's easy to see which changes were not saved.

There are few things more important than your data.    Especially the scheduling data you 
rely on to plan your future and to track your accomplishments.    On a daily basis make 
backups of    all *.PAK files as well as your archived schedules (*.LOG files). These backups 
should be made on reliable media and stored in a safe place. 



Schedule Archiving
A schedule will be automatically "archived" seven days after all items on that day have been
either marked done, rescheduled, carried forward, or deleted. That is, nothing remains on 
the day, but items marked done. Those completed items are archived to monthly log files 
named according to the month and year.    For example: "Jan91.Log"    Note: In order to 
conserve RAM, there is an exception to the seven day wait:    If you have more than 300 
items (total) in Above & Beyond, archiving will occur one day after all items on the day have 
been done.

To view the archived schedules for a particular month, select any schedule in that month; 
then choose View: History for Month.    (See Selecting Schedules for more information on how
to select schedules.)    The archive files are ASCII format (text) and may also be displayed or 
printed using the TYPE or PRINT commands of DOS, Windows notepad, or other utility 
applications, including text editors.

If you wish to view or print a log file which contains all currently completed items, use the 
Archive Completed Schedules command in the Options menu.    This will archive all done 
items, even those that were marked done less than seven days ago.    To print the log file 
select View: History for Month and then select File: Print in the notepad.

Log files are formatted with tab-separated values so they can also be read as text files by 
spreadsheets such as Microsoft Excel and Lotus 1-2-3.    To make it simpler for you, durations 
are in one type of units: minutes.



Automatic Launch of Applications
There may be times when you want to run a program or application at a precise time 
without having to manually initiate it.    This feature is activated by either of the two 
keywords, "Exec" or "Autoexec".    When either one of these words is included in the item 
title the feature is enabled.    You may specify parameters which will be passed to the 
program.

When the keyword "Exec" is used, and the scheduled begin time for that item is reached, a 
dialog box will be displayed which has the current time and the message, "Ready to Exec 
<program name>?"    At that time, choose "yes" to run the program, or choose "no" to 
cancel the process. If run, the item will automatically be marked as done in the schedule.

When the keyword "Autoexec" is used, and the scheduled begin time for that item is 
reached, the program will automatically be run without waiting for you to reply to a prompt.   
As with "Exec", the item will be marked as done in the schedule.
 
If you would prefer that Exec or Autoexec not mark the item done, but "Start" the item 
instead, simply enter the keyword in lower case ("exec" or "autoexec").    For details on the 
Start Item command see Edit: Start Item in the Menu Reference section.

You can manually launch an Exec or Autoexec item prior to its designated begin time.    
Simply select the item, then press F5 (or use Edit: Start Item).

Both Windows and non Windows programs, plus batch and command files may be run using 
these commands. If the program is a Windows application, the program window will appear 
in front of any other active windows and will have the focus. If it is a non Windows program, 
the system will automatically switch to the DOS environment to run it. When the program 
ends, the system will switch back into the Windows environment. 
 
Programs and executable files must end in either ".EXE", ".BAT", or ".COM".    For programs 
and executable files with names ending with .BAT or .COM, the .BAT or .COM suffix must be 
included with the name, otherwise the system will not be able to locate the program or file.   
For programs with names ending with .EXE, the ".EXE" is optional.
 
Note: Unless you specify the path explicitly (e.g.    Exec    c:\mydir\backup.bat),    the PATH 
statement in Autoexec.BAT must include the directory in which the program or file is to be 
found.
    
The format for an Exec or Autoexec item title is: 
 
<Description>    <Keyword>    <Program name>    <Parameters> 
 
<Description> is any text.    <Keyword> is either    Exec, exec, Autoexec, or autoexec.    
<Program name> is the    name of the program or executable file you want Above & Beyond 
to load and run.    <Parameters> are any information that the program needs to perform.

All of the four parts above are optional.    For example, you may want to use the keyword 
"Autoexec" with no program name to simply have an item (e.g. "Lunch") automatically 
marked as done.

The description, keyword, program name and parameters are all typed into the Title line in 
the definition dialog box used to create the item, and they will be displayed on the schedule 
in the normal fashion.



The keyword, program name and all parameters must be separated from each other by 
(only) one space.    

Note: When running in a LAN environment and viewing someone else's schedule, you may 
temporarily disable their Exec and Autoexec launching by choosing Options: Alarms Off.    
Note that the setting you select for this option on their Above & Beyond schedule affects 
only your viewing of their schedules.    That is, Exec and Autoexec will still be functional 
when they view their Above & Beyond schedules from their workstation.

Exec Example 

Example Item #1:

Backup    manuscript    Exec    C:\mydir\mybackup.bat    B: 
 
In this example, the description of the function you want to accomplish is "Backup 
manuscript".    The keyword Exec instructs Above & Beyond to prompt you before it loads 
and runs the batch file.    This will give you time, for example, to put a blank diskette into the
drive.    "mybackup.bat" is a batch file you created to make backup copies of the manuscript. 
You wrote the batch file so that it would copy onto any disk drive you specify.    Here, you 
have specified the parameter "B:",    indicating that you want to use drive    B:    this time. 

Autoexec Example

Example Item #2:
 

Autoexec    Notepad
 
In this example, there is no descriptive text.    You chose the keyword    Autoexec    this time 
because this is a high priority item and the program must run at the specified time.    
Notepad is the name of the program that will be run, and it requires no parameters. 



Workgroup Use

Summary of Features

1.    You can view and update the schedules of other Above & Beyond users.    Note, however,
that these schedules must be in directories to which you have read and write access.    One 
or more of these schedules can be based on local area network (LAN) servers.    Multiple 
schedules can be viewed on your screen in overlapping windows. 

2.    You can delegate items easily by "cutting" items from your schedule and "pasting" them 
into the schedules of co-workers.    

3.    You can check on the status of items being performed by others in the group.    If the 
item is completed you'll see it marked done; if it is coming up, you can see when the person 
plans to get to do it.

4.    You can easily schedule meetings when a group of others (and yourself) are available.    

5.    You can post electronic mail by inserting notes into another person's schedule.
 
6.    A common company phone book may be created which can be accessed by every Above
& Beyond user.    If the company phone numbers are stored in a cardfile named "phone.crd" 
then simply add the following entry to each user's Worktools list:

Company Phone Book cardfile.exe phone.crd

7.    Users can be restricted for viewing and/or changing the schedules of other users.    This 
is done by setting passwords for the various levels of access.    See Options: Set Passwords.



Opening Schedules
In order to look at or update the schedules of others, you must first "open" the user; which 
means that their schedules will appear on your screen.    A list of the "open" users is 
displayed in the Schedules menu.    For instructions on how to "open" users, see the section 
on the Schedules menu .



Workload Management
Supervisors who assign work can monitor and adjust the workload and priorities of each 
worker in a precise way.    Above & Beyond schedules show clearly the workload on each day,
in percentages, amounts, and even graphically with use of color on the pop-up calendar. 

Supervisors know ahead of time when a worker is running out of things to do, or on the other
hand, if too much work is piling up.    Supervisors can see when workers will be getting to 
particular items, and shift the work sequence based on new priorities.



Status Query
Supervisors can check the completion status of any item at any time, without interrupting 
the worker. The worker doesn't even have to be available, which is important if they are 
working at another location, at lunch, on the phone, out sick, or on another shift. This is an 
enormous time saver. If the supervisor finds the item has not been completed, he can also 
see when the worker has planned to get to it.



Passwords
Users can be restricted for viewing and/or changing the schedules of other users.    This is 
done by setting passwords for the various levels of access.    For more information See 
Options: Set Passwords in the Menu Reference section.



Meetings for several Above & Beyond users can be planned jointly. The cost of trying to find 
out when everyone in the group is free 
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